REN ESAS Application Note

RZ/G3S
AWO Example Project Start-up Guide

Introduction

This application note describes how to set up and execute RZ/G3S AWO Example Project.

Target Device

RZ/G3S

Contents

1. SPECIfICAtIONS ... 3
I B B 1= 11T = o] o PP PP UPP PP 3
2. Proven ENVIFONMENT .. ... e et e e et e e e e et e e e e et e e e e et e eeeebanaaaees 3
3. AWO Example ProjeCt SetUP........oouiiiiiii e 3
K B A e =S Y1 (F o RO OSSP OTRRS 3
3.2 RZIG VLP SBIUP ...ttt et ettt ettt e b e et e e et e e et e e eabe e e teeebee e aabeeebeeeeareas 3
3.2.1 USING RZIG VLP V3.0.7 ..ottt ettt ettt et et e et e e et e e e teeeebae e sabeeeeneeeenneas 3
3.2.2  USING RZ MPU VLP VA.0.T ..ottt et et e ate e st e e s ateessteeate e e snbeeeseeasaeesnseeenneeesnneas 4
3.3 How to build AWO EXamPIe PrOJECL..........uuiiiiie ittt e st e e e e e e st e e e e e e s enanes 5
3.4  How to deploy AWO EXamPIE PrOJECE.........ueiiiiiii ittt e e e e e e e e e e e e aaans 7
K0 Nt B Lo T @ S W oo o A (X 1Y OO OP R OTRRR 7
3.4.2  FOr €MMOC DOOL (1.8V) .. ettt ettt e et e et e e et e e e aeeebee e sabeeeeseeeenneas 8
4.  AWO Example Program INVOCALION ............oouiiiiiiiiiieii e e e 9
5. Sequence Diagram of AWO Example Project.........cccoooiiiiiiiiiiii e, 11
5.1 Brief Sequence of AWO EXamPIe PrOJECE.........coi it a e e e e 11
5.2 SUuSPeNd SEQUENCE OFf TF-A ... .ot e et et e e e e e st e e e e e e e s s et sbaeeeaaeessesrsreeeaaeeaaannns 12
5.3  ReSUME SeqUENCE Of THF-A ... ittt ettt e e e e e et e e e e e e e e e eneeeeaaae e e s neneeeeaaaeaaannes 13
6. Assignment of peripherals for AWO MOAE ........cooiuiiiiiiiiiicee e, 14
7. Function Reference of AWO Example Project ...t 15
A% O = o T =T Q=T oL PP PPPRPPRPNt 15
A0 A o - To: (U o T -0 PP PPPPPPRRNt 15
7400 P T =T~ A ] 1 1 o2 PR PPPPPPPPNt 16
A S ) G o= Lo T T ][ o SO 16
4% S T o T o =T o T =Y =) o o J SR 16
4% G T =] (o o T o= Lo T o1 [ Yo -SSR 17
A B A= =T = o o= T =Y T= ] SR PPPPPPRRNt 17
400 < T =1 (o o T .11 Yo [ = PP PPPPPPRRNt 18
A e ) (o) o e (o Yo Q= TS 1=T= T o (=T = SOt 19

RO1AN7396EJ0400 Rev.4.00 Page 1 of 27
Mar.31.26 RENESAS



RZ/G3S AWO Example Project Start-up Guide

7.1.10 sleep_enable_ON_grEENPACK ..........uuuuuuuuuueuueiiiieieieeeeetaeeeae e ererereeeaete s easetsessesesssssnsssnsnsnsnsnsnsnnes 19
7.1.11 sleep_enable_Off gre@nPACK .......ooo oot e e e e e e e e e e e annas 20
7.1.12 wait_pd_iSOVCC _STADIE ...t e e e e et e e e e e e e s e e e e e e e e aaanas 20
4% 1 T o o I E=T AV oo Lo Y=Y =T ] o) USRS 20
7.1.14 restore_sram_repair_iNfOrMation ............ouiiiiii i e e e e e e e st e e e e e e e e eanes 21
% I R T =To F= Y (I T o T o101V e [ 1./ o SRRt 21
7.1.16 Start_SYSIEM _DUS_ ClOCK ......uuuiiiiiiiiiiiiiiiiiiitieit ettt te s ts s tsts s ts s s tnsssnsssnsnsnsnsnnnnnnes 21
7117 negate_SYSIEmM_DUS FESEL ... .. ittt e e e e e e et e e e e e e e e eeeeaaeeeeannes 22
4% ST = L 14T Yo L1 ][ USSR 22
40 T == (o =TT = o o SR 22
A A O T=To =) (R o= Lo TS T (=TT PR PPPRPPRPNt 23
G TR LY o o T= Lo | U 24
8.1  Debugging CM33 AWO Example Project from e2studio...........cceeiiiiiiiiiiiiiiiiie e 24
S I S Tl o] L PP UPPPPPPPPPN 26
REVISION HISTOIY ...ttt nnnnnnnne 27
RO1AN7396EJ0400 Rev.4.00 Page 2 of 27

Mar.31.26 RENESAS



RZ/G3S AWO Example Project Start-up Guide

1. Specifications

1.1 Deliverables
Table 1-1. Deliverables of AWO Example Project

Deliverables File name Description
RZ/G3S AWO freertos_ w_awo_rzg3s_evk_example.zip CM33 project file for
Example Project e2studio

RZ/G3S AWO r01an7396ej0400_rzg3s_awo_example_project_start- This material.
Example Project up_guide.pdf

Start-up Guide

2. Proven Environment

Table 2-1. Proven Environment of AWO Example Project

Item Contents

Integration Development Environment e? studio 2025-12 or later
RZ/G VLP v3.0.7 and v4.0.1

RZ Flexible Software Package (FSP) V4.0.0

3. AWO Example Project Setup

3.1 RZFSP Setup
Please refer to Getting Started with RZ/G Flexible Software Package.

3.2 RZ/G VLP Setup
3.21 Using RZ/G VLP v3.0.7
This section described how to integrate AWO related stuff to RZ/G VLP v3.0.7.

1. Follow the procedure from the beginning of 2.2 Building Images to (3) Add layers of SMARC EVK of
RZ/G3S Linux Start-up Guide.

2. Download Multi-OS Feature Package (r01an8260ej0400-rz-multi-os-pkg.zip) to your working directory
and run the commands stated below:

$ cd ~/rzg vlp <pkg ver>
$ unzip <Multi-OS download dir>/r01an8260ej0400-rz-multi-os-pkg.zip
$ tar zxvf r01an8260ej0400-rz-multi-os-pkg/meta-rz-features multi-os v4.0.0.tar.gz

3. Uncomment the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-rzg3s-
vip3/conf/layer.conf for enabling AWO support:

#MACHINE FEATURES append = " RZG3S CM33 REMOTEPROC"
MACHINE FEATURES append = " RZG3S CM33 FIRWARE LOAD"
#MACHINE FEATURES append = " RZG3S CM33 COLDBOOT"
MACHINE FEATURES append = " RZG3S AWO SUPPORT"
RO1AN7396EJ0400 Rev.4.00 Page 3 of 27
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4. Add the layer for Multi-OS Package, simply run the helper script and select the meta-rzg3s-vip3 layer
from the list.

$ cd build
$ bash ../meta-rz-features/meta-rz-multi-os/add meta layer.sh

6. Continue to set up VLP by following (4) - (5) of 2.2 Building images in SMARC EVK of RZ/G3S Linux
Start-up Guide.

3.2.2 Using RZ MPU VLP v4.0.1
This section described how to integrate AWO related stuff to RZ MPU VLP v4.0.1.

1. Follow the procedure from the beginning of 2.2 Building Images to (3) Add layers of SMARC EVK of
RZ/G3S Linux Start-up Guide.

2. Download Multi-OS Feature Package (r01an8260ej0400-rz-multi-os-pkg.zip) to your working directory
and run the commands stated below:

$ cd ~/rzg vlp <pkg ver>
$ unzip <Multi-OS download dir>/r01an8260ej0400-rz-multi-os-pkg.zip
$ tar zxvf r01an8260ej0400-rz-multi-os-pkg/meta-rz-features multi-os v4.0.0.tar.gz

3. Uncomment the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-rzg3s-
vipd/conf/layer.conf for enabling AWO support:

#MACHINE FEATURES:append = " RZG3S_CM33 REMOTEPROC"
MACHINE FEATURES:append = " RZG3S_CM33 FIRMWARE LOAD"
#MACHINE FEATURES:append = " RZG3S_CM33 COLDBOOT"
MACHINE FEATURES:append = " RZG3S_AWO SUPPORT"

4. Add the layer for Multi-OS Package, simply run the helper script and select the meta-rzg3s-vip4 layer
from the list.

$ cd build
$ bash ../meta-rz-features/meta-rz-multi-os/add meta layer.sh

5. Continue to set up VLP by following (4) - (5) of 2.2 Building images in SMARC EVK of RZ/G3S Linux
Start-up Guide.
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3.3 How to build AWO Example Project
Here is the procedure to build AWO Example Project:

1. Deploy and boot up Linux by following 3. Preparing the SD Card, 4. Reference Board Setting and 5.
Booting and Running Linux of SMARC EVK of RZ/G3S Linux Start-up Guide.

2. Extract freertos_w_awo_rzg3s_evk_example.zip on your development PC.

3. Launch e? studio and click File > Import.

B Workspace - ¥ studio
File Edit Source Refactor Navigate Search Project

New Alt+Shift+M >
Open File...
3 Open Projects from File System...
Recent Files »
lose Editor

Close All Editors Ctrl+Shift+W
Save Ctrl+

Save As...

Save All Ctrl +Shift
Revert

Move...

Rename... F2
Refresh Fs

Convert Line Delimiters To »

@5

Print... Ctrl+P
Import...
Export...

G [

Properties Alt+Enter
Switch Workspace )
Restart

Exit

Figure 3.1 Import of CM33 AWO Example Project (1)

4. Select Existing Projects into Workspace and click Next >.

& import m] *
Select \“
Create new projects from an archive file or directory. g 5 |

Select an import wizard:

(- Existing Projects into Workspace ~
(= File System

o GNUARM-MONE/RZ(DS-5) project conversion to GCC ARM Embedded

[T] Preferences

(4 Projects from Folder or Archive

2% Rename & Import Existing C/C++ Project into Workspace

& Reneas Web 1 b EOHT)L-FOSTIH

e Renesas CATEKOR (C5+) JOUTI b

Ta# Renesas CC-RX. CC-RL. H&TFCC-RH (CS+) 7OUTIR

Ta# Renesas GitHub FreeRTOS (with |oT libraries) 70517k

= C/C++

(= Install

= Oomph

= Run/Debug

(2=, Tear b
(?;‘ < Back Einish Cancel

Figure 3.2 Import of CM33 AWO Example Project (2)
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5. Input the path to the directory where freertos_w_awo_rzg3s_evk_example project was extracted and

click Finish.

Q Import

Import Projects

Select a directory to search for existing Eclipse projects.

() Select root directory:

Browse...

O Select archive file:

Ci\Usersha3149982\Desktopclone_test\gitla ~

Browse...

Projects:

@ freertos_w_awo_rzg3s_evk_example (freertos_w_awo_rzg3s_evi_exa

Select All

Deselect All

Refresh

Options
Search for nested projects

Copy projects into workspace

[ Close newly imported projects upon completion

[ Hide projects that already exist in the workspace

Working sets

(] Add project to working sets

@ < Back

Mext >

New...

Select...

Cancel

Figure 3.3 Import of CM33 AWO Example Project (3)

6. Build freertos_w_awo_rzg3s_evk_example project from Project > Build All or Build Project.

8 e2studio_122025 workspace - e* studio

File Edit Source Refactor Navigate Search [Project | Renesas Views Run Renesas 365 Renesas Al

B-R- B uit-Q-

Project Explorer X =

Close Project

L Open FSP Configuration
v 5 freertos_w_awo_rzg3s_evk_ ple [Debu¢
» i)l Includes |eio Build All Ctrl+Alt+B |
8 src Build Configurations - >
» (& script Build All
st Build Project ©umes
12 configuration.xml : :
freertos_w_awo_rzg3s_evk_example Debug_ Build Working Set >
X] freertos_w_awo_rzg3s_evk_example Debug_ Clean...
freertos_w_awo_rzg3s_evk_example Release Build Automatically
X) freertos_w_awo_rzg3s_evk_example Release
() rz_cfg.txt Build Targets >
C/C++ Index >
|@* Update All Dependencies Alt+D
Change Device
Change Toolchain Version
& C/C++ Project Settings Ctrl+Alt+P

Properties

Figure 3.4 Build CM33 AWO Example Project

7. If the build is successfully completed, you can see the build artifact in Debug or Release directory as

stated below:
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v (= Debug
rEr
> & rz_gen
> = sic
|» ?;; freertos_w_awo_rzg3s_evk_example.elf - [arm/le] |
compile_commands.json

=| freertos_w_awo_rzg3s_evk_example_cm33boot.srec
= freertos_w_awo_rzg3s_evk_example_cm33fpu.srec
| freertos_w_awo_rzg3s_evk_example_non_secure_code.bin
| freertos_w_awo_rzg3s_evk_example_non_secure_vector.bin
;| freertos_w_awo_rzg3s_evk_example_secure_code.bin
| freertos_w_awo_rzg3s_evk_example_secure_vector.bin
= freertos_w_awo_rzg3s_evk_example.elf.in
B freertos_w_awo_rzg3s_evk_example.map
freertos_w_awo_rzg3s_evk_example.rpd
# freertos_w_awo_rzg3s_evk_example.sbd
- freertos_w_awo_rzg3s_evk_example.srec
© makefile

makefile.init
| memory_regions.ld
5 objects.mk
& sources.mk

5/F

Figure 3.5 Build Artifact of CM33 AWO Example Project

3.4 How to deploy AWO Example Project
This section describes how to deploy the AWO example program built in the previous chapter to the board.

To write to the SPI flash on the board, use the Flash Writer in the RZ/G VLP Linux package.

3.4.1 For QSPI boot (1.8V)

1. Follow the procedure from the beginning of 4 Reference Board Setting to 4.4 Write the Bootloader of
RZ/G3S Linux Start-up Guide.

2. Program freertos_w_rzg3s_evk_example.srec with Flash Writer as shown below:

===== Qspi writing of RZ/G2 Board Command =============

Load Program to Spiflash

Writes to any of SPI address.

Program size & Qspi Save Address

===== Please Input Program Top Address ============
Please Input : H'80200000

===== Please Input Qspi Save Address ===
Please Input : H'200000
please send ! ('.' & CR stop load)
Erase SPI Flash memory...
Erase Completed
Write to SPI Flash memory.
======= Qspil Save Information =================
SpiFlashMemory Stat Address : H'00200000
SpiFlashMemory End Address : H'0020D16E

3. Continue to set up board by following 4.5 Change Back to Normal Boot Mode in SMARC EVK of
RZ/G3S Linux Start-up Guide.
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3.4.2 For eMMC boot (1.8V)

1. Follow the procedure from the beginning of 8.2 How to boot from eMMC to Send the data of “fip-

smarc-rzg3s.srec” in 8.2.1 Writing Bootloader for eMMC Boot.

2. Program freertos_w_rzg3s_evk_example.srec with Flash Writer as shown below:

> EM W
EM W Start —-—-—-—-=-===—-—-———-

Please select,eMMC Partition Area.

0:User Partition Area : 62160896 Kbytes
eMMC Sector Cnt : H'O - H'O768FFFF
1:Boot Partition 1 : 32256 Kbytes
eMMC Sector Cnt : H'O - H'OOOOFBFF
2:Boot Partition 2 : 32256 Kbytes

eMMC Sector Cnt : H'O - H'OOOOFBFF
Select area (0-2)>1
-- Boot Partition 1 Program —--—————-——————————————————————
Please Input Start Address in sector :1000
Please Input Program Start Address : 80200000
Work RAM (H'00020000-H'OOOFFFFF) Clear....
please send ! ('.' & CR stop load)

3. Continue to set up board by following 8.2.1 Writing Bootloader for eMMC Boot.

RO1AN7396EJ0400 Rev.4.00
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4. AWO Example Program Invocation

This chapter describes how AWO Example Program works.

1. Boot up Linux kernel.
2. Login as root.

smarc-rzg3s login: root

3. Invoke the commands below on Linux console to move Linux to Suspend to RAM (S2R):

root@smarc-rzg3s:~# echo deep > /sys/power/mem sleep
root@smarc-rzg3s:~# echo mem > /sys/power/state

4. When Linux successfully moves to S2R, you should see the following display on Linux console:

1082.105386
1082.109183

PM: suspend entry (deep)
Filesystems sync: 0.000 seconds

[ ]

[ ]

[ 1082.122622] Freezing user space processes ... (elapsed 0.001 seconds) done.

[ 1082.131266] OOM killer disabled.

[ 1082.134496] Freezing remaining freezable tasks ... (elapsed 0.001 seconds) done.
[ 1082.143134] printk: Suspending console(s) (use no console suspendto debug)

CM33:Init PMIC for AWO mode
CM33:AWO Mode

Hit any key to go to ALLON mode.
RZ/G3S now moves to AWO, and only CM33 AWO Example Project can work. (Note)

Note: On Linux console, Line Feed (LF) should be specified as New Line Code.

RO1AN7396EJ0400 Rev.4.00 Page 9 of 27
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5. When typing any key on Linux Console, RZ/G3S starts to move to ALLON, and Linux should be resumed
as shown below:

Hit any key to go to ALLON mode.

a

CM33:Set GreenPAKto ALLON

NOTICE: BL2:
NOTICE: BL2:
NOTICE: BL2:
60. ]
.836140]

60. ]
60.

60

710450

880506
899495]

v2.7 (release):2.7.0/g3s_1.0.0_rc4

Built : 11:52:53, Feb 292024

Booting BL31

ehci-platform 11e30100.usb: port 1 resume error -110

usbusb2-portl: device 2-1 not suspended yet

Disabling non-boot CPUs

Microchip KSZ9131 Gigabit PHY 11c30000.ethernet-ffffffff:07: attached PHY driver

Microchip KSZ9131 Gigabit PHY] (mii bus:phy addr=11c30000.ethernet-ffffffff:07, irg=137)

60.

920867]

Microchip KSZ9131 Gigabit PHY 11c40000.ethernet-ffffffff:07: attached PHY driver

Microchip KSZ9131 Gigabit PHY] (mii bus:phy addr=11c40000.ethernet-ffffffff:07, irg=138)

[
[
[
[
[
[
[
[ 61.
[ 61.
[ 61.
[ 6l1.
[ 6l.
[ 6l1.
[ 61.
[ 61.
[ 61.
[ 61.
[ 61.
[ 61.

017924
018018
105918
106020
309991
313131
313647
334271
352163
619922
788714

]
]
]
]
]
]
]
]
]
]
]
798400]

usbusb3: root hub lost power or was reset
usbusbl: root hub lost power or was reset
usbusb4: root hub lost power or was reset
usbusb2: root hub lost power or was reset
OOM killer enabled.

Restarting tasks

usb2-1: USB disconnect, device number 2
done.

PM: suspend exit

usb2-1: new high-speed USB device number 3 using ehci-platform
hub 2-1:1.0: USB hub found

hub 2-1:1.0: 4 ports detected

root@smarc-rzg3s:~#

RO1AN7396EJ0400 Rev.4.00 Page 10 of 27
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5. Sequence Diagram of AWO Example Project
5.1 Brief Sequence of AWO Example Project

FreeRTOS RZ/G35

User{consola)
=TaskCreates

AWD mode message

key input from console

FreeRTOS RZ/G35

User{console)

Figure 5.1 Brief Sequence of AWO Example Project
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5.2 Suspend Sequence of TF-A

Linux TF-A RZ/G35 DDR SDRAM

Secure call
N

psci_cpu_suspend_start()

Update power state(by core)

-

rz_pwr_domain_suspend()

Disables the GIC CPU interface of the calling CPU

Read for save

GIC Redistributor register context

Read for save

GIC Distributor register context
N LU PNt
Enable CA55 core0 sleep mode requirement interrupt
i o
desw_op_all()
Cache flush
R |
disable_mmu_el3()
Disable the MMU at EL3
R |

cpg_prepare_suspend()

Write CPG clock on reg(I2C0/VBATT request on)

ddr_retention_entry()

Configure DDR PHY retention mode

Setup
e
| P
cpe_suspend_setup()
Write CPG module stop reg(request stop)
Linux TF-A RZ/G35 DDR SDRAM

Figure 5.2 TF-A Suspend Sequence
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5.3 Resume Sequence of TF-A

Linux TF-A:BL31 TF-A:BL2 BL1 RZ/G3S DDR SDRAM
Boot BL2
£
~

bl2_security_setup()

Setup TZC
P e PP >
Setup Master/Slave access control
e PSSR L

Storage

plat_ddr_setup()

Read

Boot image

) N Y SR
Exit DDR PHY retention mode
Setup
-
e eeeeemeemeeeeeeeesemesees el eeeeeeeemeeeeeeesesemeneeeen) M ]
pwrc_board_is_resume()
Read VBATT flag
VBATT flag
R PR
Clear VBATT flag
e PSSR L
SMC
R
Boot BL31
T~
bl31_platform_setup()
GIC initialize
P e P o
Page table configure
P s PP *
Update reset vector
P e e P >
bl31_prepare_next_image_entry()

EL1/EL2 context initialize

e o PP, >
arm_bl31_plat_runtime_setup()
Console initialize
P T o PP PP >
el3_exit()
<
Linux TF-A:BL31 TF-A:BL2 BL1 RZ/G3S DDR SDRAM

Storage

Figure 5.3 TF-A Suspend Sequence
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6. Assignment of peripherals for AWO mode

On RZ/G3S, only the peripherals which belong to PD_VCC domain can continue to work under AWO mode.
For details, please refer to 41. Low Power Consumption in RZ/G3S Group User’'s Manual. Table 6.1 shows
the expected assignment of peripherals to CA55 and CM33 on this example project.

Table 6.1 Peripherals assignment on AWO Example Project

Peripherals CPU Remarks
CA55 CM33

ADC X

CANFD X

DMA (Non Secure) X

DMA (Secure) X

GPT

12C

I3C

MTU3

POE

POEG

XXX X[ X X]| X

SCI

SCIF ch0, ch2-5 ch1 Assumed use case of SCIF ch1 on CM33 is to get
Pmod USBUART to be worked for the console
dedicated to CM33.

SPDIF X
RSPI ch1-4 ch0 Assumed use case of RSPl ch0 on CM33 is to get
Pmod SF3 to be worked on RZ/G3S Smarc EVK.
SSli X
TSU X
WDT chO ch1, ch2
GTM ch4-7 ch0-3
xSPI X
RO1AN7396EJ0400 Rev.4.00 Page 14 of 27
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7. Function Reference of AWO Example Project
711 awo_task_entry

void awo task entry (void *pvParameters)

e Parameters
e pvParameters
Pointer to the parameter passed to AWO task.

e Returns
None

o Description

This function is the entry function of AWO task.

Here is the overview of processing flow:

1. Set up timer.

Wait until Arm® Cortex®-A55 (hereinafter referred to as CA55) Linux enters Suspend-to-RAM.
Configure RZ/G3S and PMIC as AWO.
Wait until key input to console is issued.
Configure RZ/G3S and PMIC as ALLON.
Return to 2.

ook wd

7.1.2 backup_sram

static void backup sram(uint32 t *sys cab5 cfg rval back,
uint32 t *sys ca55 cfg rvah back)

o Parameters
e sys cab5 cfg_rval_back
Pointer to the buffer where lower 32-bit of reset vector base address is stored.
e sys cab55 cfg_rvah_back
Pointer to the buffer where upper 32-bit of reset vector base address is stored.

e Returns
None

e Description
This function first copies the contents in SRAM ACPUO to the dedicated area in SRAM MPU1. Then,
CADb55 reset vector address should be copied to the buffer specified by the parameters.

The reset vector base address will be restored when transiting from AWO to ALLON mode for the resume
of CA55 Linux.

RO1AN7396EJ0400 Rev.4.00 Page 15 of 27
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7.1.3 set_pmic

static void set pmic(void)

Parameters
None

Returns
None

Description
Configure Power Management IC (PMIC) RAA215300A2GNP#HA3 mounted on RZ/G3S SMARC EVK
specific to AWO mode.

7.1.4 wait_ca55_sleep

static void wait cab5 sleep(void)

Parameters
None

Returns
None

Description

Issue the request to CA55 Linux to transit to sleep state and wait until the transition is completed.

7.1.5 q_channel_stop

static void g channel stop(void)

Parameters
None

Returns
None

Description
Stop clock supply to peripheral clock domain and bus bridge via Q-Channel.
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7.1.6 stop_ca55_clock

static void stop cab5 clock(void)

e Parameters
None

e Returns
None

o Description
Stop the clock supply to CA55.

7.1.7 assert_ca55 reset

static void assert cab5 reset (void)

e Parameters
None

e Returns
None

o Description
Carry out reset assertion of CA55.
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7.1.8 stop_module

static void stop module (void)

e Parameters

None

e Returns

None

o Description

Transit all the modules assigned to the registers listed below to Module Stop State:

MSTOP Register ACPU (CPG_BUS_ACPU_MSTOP)

MSTOP Register PERI_COM (CPG_BUS_PERI_COM_MSTOP)
MSTOP Register PERI_DDR (CPG_BUS_PERI_DDR_MSTOP)
MSTOP Register TZCDDR (CPG_BUS_TZCDDR_MSTOP)
MSTOP Register MHU (CPG_MHU_MSTOP)

Power Down MSTOP Register (CPG_PWRDN_MSTOP)
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7.1.9 stop_clock_assert_reset

static void stop clock assert reset(void)

Parameters
None

Returns
None

Description
Stop the clock supply assigned to the registers listed below:
¢ Clock Control Register AXI_ACPU_BUS (CPG_CLKON_AXI_ACPU_BUS)
e Clock Control Register AXI_COM_BUS (CPG_CLKON_AXI_COM_BUS)
e Clock Control Register PERI_COM (CPG_CLKON_PERI_COM)
¢ Clock Control Register PERI_DDR (CPG_CLKON_PERI_DDR)
e Clock Control Register AXI_TZCDDR (CPG_CLKON_AXI_TZCDDR)
e Clock Control Register Cortex-M33 (hereinafter referred to as CM33) (CPG_CLKON_CM33)
e Power Down IP Register 1 (CPG_PWRDN_IP1)
e Power Down IP Register 2 (CPG_PWRDN_IP2)
Configure the unit clock associated with the register below as Power Down mode:
e Power Down CLKON Register (CPG_PWRDN_CLKON)
Cofigure the reset pin associated with the register below as Power Down mode:
e Power Down RST Register (CPG_PWRDN_RST)
Assert the reset signal associated with the registers listed below:
¢ Reset Control Register AXI_ACPU_BUS (CPG_RST_AXI_ACPU_BUS)
¢ Reset Control Register AXI_COM_BUS (CPG_RST_AXI_COM_BUS)
¢ Reset Control Register PERI_COM (CPG_RST_PERI_COM)
¢ Reset Control Register AXI_TZCDDR (CPG_RST_AXI_TZCDDR)
Turn off the USB Region Power by configuring USB PWRRDY Register (SYS_USB_PWRRDY).
Assert PCI_ARESETN reset signal with SYS_PCIE_RST_RSM_B and wait until it's actually asserted by
monitoring Reset Monitor Register PCl (CPG_RSTMON_PCI register.

7.1.10 sleep_enable_on_greenpack

static void sleep enable on greenpack(void)
Parameters

None

Returns
None

Description
Configure Sleep Enable of GreePAK (SLG7RN46131) connected with RIIC ch1 as ON.

RO1AN7396EJ0400 Rev.4.00 Page 19 of 27
Mar.31.26 RENESAS



RZ/G3S AWO Example Project Start-up Guide

7.1.11 sleep_enable_off _greenpack

static void sleep enable off greenpack(void)
e Parameters

None

e Returns
None

o Description
Configure Sleep Enable of GreePAK (SLG7RN46131) connected with RIIC ch1 as OFF.

7.1.12 wait_pd_isovcc_stable

static void wait pd isovcc_stable (void)

e Parameters
None

e Returns
None

e Description
Wait for the power supply for PD_ISOVCC from PMIC. In the current sample program, 5 msec wait is
inserted as an example. Then, DDR is turned on.

7.1.13 pd_isovcc_power_supply

static void pd isovcc power supply(void)

e Parameters
None

e Returns
None

o Description
Disable the isolation cell for PD_ISOVCC.
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7.1.14 restore_sram_repair_information

static void restore sram repair information (void)
e Parameters

None

e Returns
None

o Description
Restore SRAM repair information.

7.1.15 negate_ip_power_down

static void negate ip power down (void)
e Parameters

None

e Returns
None

o Description
Negate Power Down mode of IPs assigned to PD_ISOVCC region.

7.1.16 start_system_bus_clock

static void start system bus clock(void)
e Parameters

None

e Returns
None

e Description
Start the clock supply to System Bus and Peripherals assigned to PD_ISOVCC region.
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7.1.17 negate_system_bus_reset

static void negate system bus reset (void)
e Parameters

None

e Returns
None

o Description
Negate reset signal of System Bus and Peripherals assigned to PD_ISOVCC region.

7.1.18 start_module

static void start module (void)

e Parameters
None

e Returns
None

o Description
Transmit Peripherals assigned to PD_ISOVCC from Module Stop State to Normal Operation state.

7.1.19 restore_sram

static void restore sram(volatile uint32 t *dummy read)

Parameters
e dummy_read
Pointer to the buffer where SRAM ACPUOQ data to be backed up by backup_sram function is
stored.

e Returns
None

e Description
Restore SRAM ACPUO data that was backed up by backup_sram function. Be sure to call this function
after backup_sram is invoked. Otherwise, the data copied to SRAM_ACPUO should be unpredictable.
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7.1.20 negate_cab55_reset

static void negate cab55 reset (uint32 t sys cab5 cfg rval back,
uint32 t sys cab5 cfg rvah back)

o Parameters
e sys cab5 cfg_rval_back
Lower 32-bit of reset vector address to be backed up by backup_sram function.
e sys ca55 cfg_rval_back
Upper 32-bit of reset vector address to be backed up by backup_sram function.

e Returns
None

o Description
Start the clock supply to CA55 and then carry out the reset release of CA55.
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8. Appendix
8.1 Debugging CM33 AWO Example Project from e2studio
This chapter describes how to debug an AWO example project from e2studio.

If you want to debug from e2studio, you need to rebuild TF-A. Follow the steps below to recreate the TF-A.

1. If you build RZ/G VLP v3.0.7, at Step 3 of “3.2.1 Using RZ/G VLP v.3.0.7"
Uncomment only the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-
rzg3s-vilp3/conf/layer.conf for enabling AWO support:

#MACHINE FEATURES append " RZG3S CM33 REMOTEPROC"

#MACHINE FEATURES append = " RZG3S CM33 FIRMWARE LOAD"
#MACHINE FEATURES append = " RZG3S CM33 COLDBOOT"
MACHINE FEATURES append = " RZG3S AWO SUPPORT"

If you build RZ MPU VLP v4.0.1, at Step 3 of “3.2.2 Using RZ MPU VLP v.4.0.1
Uncomment only the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-
rzg3s-vilp4/conf/layer.conf for enabling AWO support:

#MACHINE FEATURES:append = " RZG3S_CM33 REMOTEPROC"
#MACHINE FEATURES:append = " RZG3S_CM33 FIRMWARE LOAD"
#MACHINE FEATURES:append = " RZG3S_CM33 COLDBOOT"
MACHINE FEATURES:append = " RZG3S_AWO_ SUPPORT"

2. Write the rebuilt TF-A to the board according to 3.4 How to deploy AWO Example Project.

Once you have completed the above preparations, open the AWO project in e2studio and start debugging by
following the steps:
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1. Configure the debugger for freertos_w_awo_rzg3s_evk_example project from Run > Debug

Configurations....

Q e2studio_122025_workspace - &* studio

File Edit Source Refactor Navigate Search Project RenesasViews Renesas365 Renesas Al Window Help

| B - K ~iBinit~Q-
Project Explorer X R Y @ B
V|5 freertos_w_awo_rzg3s_evk_ pl lDebug_]j

> 2, Binaries ;

Y Includes %

B
2 rz_gen
B src 0
(& Debug
= rz_cfg
(= script
{8 configuration.xml *

0

»

VoV vV Vv v

Renesas Debug Tools >
Run Ctrl+F11
Debug F11
Run History >
Run As >

Run Configurations...

Debug History >
Debug As >

5| freertos_w_awo_rzg3s_evk_example Debug_Flat.jlink

Debug Configurations...

|X] freertos_w_awo_rzg3s_evk_example Debug_Flat.launch
|5 freertos_w_awo_rzg3s_evk_example Release_Flat.jlink
|X] freertos_w_awo_rzg3s_evk_example Release_Flat.launch
() rz_cfg.txt

Breakpoint Types >

Skip All Breakpoints

External Tools >

Figure 8.1 Debug Configuration of CM33 AWO Example Project (1)

2. Extract Renesas DGB Hardware Debugging, choose
Debug_Flat or Release_Flat and click Debug.

freertos_w_awo_rzg3s_evk_example

8 Debug Configurations

o X

&

Create, and run g
T EPRX BT -
type filter text

[€] C/C++ Application

[€] C/C++ Remote Application

|- EASE Script

[€] GDB Hardware Debugging

[c7] GDB Simulator Debugging (RH850)

@’ lronPython Run

@ IronPython unittest

& Jython run

@Y Jython unittest

@ Launch Group

] PyDev Django

23 PyDev Google App Run

@P Python Run

#" Python unittest

[£7] Renesas GDB Hardware Debugging
I—EJ freertos_w_awo_rzg3s_evk_example Debug_FIat]
[ freertos_w_awo_rzg3s_evk_example Release_Flat

[c7] Renesas Simulator Debugging (RX, RL78)

<

Filter matched 18 of 20 items

Name: freertos_ w_awo_rzg3s_evk_example Debug_Flat

[5) Main| 35 Debugger| & Startup | & Source| ] Common

Project:

freertos_w_awo_rzg3s_evk_example Browse...
C/C++ Application:

Debug/freertos_w_awo_rzg3s_evk_example.elf

Variables... Search Project... Browse...
Build (if required) before launching
Build Configuration: 'Use Active v
() Enable auto build () Disable auto build
© Use workspace settings Configure Workspace Settings...

Figure 8.2 Debug Configuration of CM33 AWO Example Project (2)
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3.  Now the load module of CM33 AWO Example Project has been loaded and Program Counter (PC)
should indicate the top of Entry_Function_S function. Then, click Run > Run to continue the

invocation.
8 e2studio_122025_workspace - freertos_w_swo_rzg3s_evk_example/rz/fsp/src/bsp/cmsis/Device/RENESAS/Source/systems.c - &° studio = (u] X
File Edit Source Refactor Navigate Search Project Pydev RenesasViews Run Renesas 365 Renesas Al Window Help
B a0 /Do [ueNre e PR H- Qi m-WEY PSS Q& NotConnected
&5 | By C/C++ 45 Debug t
Debug X B % i |é § = B8 [Qsystemse X = B  Eventpoints X -
v [£] freertos_w_awo_rzg3s_evk_example Debug_Flat [I [ill1 . DOXYGED B w X %0
v (T freertos_w_awo_rzg3s_evk_example.elf [1] [cor = |17° ! — p : =
~ o Thread #1 1 (single core) [core: 0] (Suspenc B8 ° ‘vm;“Entry_lunc;wn_;(\dr;i;;gWg A Load. Using io-depuge PC:0/80A0/4 | B | 4

[ Entry_Function_S( at systems.c:177 0xZ: |

A
» arm-none-eabi-gdb (16.2) O * Set the main stack pointer to BSP_PRV_SECURE_STAC
1] Renesas GDB server (Host) 81177 000239dc __asm volatile ("msr msp, %0"
: "r" (BSP_PRV_SECURE_STACK_TOP) [
) () €4 EventBreak
)i (COa_* Timer Start
O+ Timer Stop
__asm volatile (“b.w %0" =
: "i" (&entry_function_sub)
187 )i
| P }
= static void entry_function_sub (void)
{
* Set Secure vecto address to SYSC *
R_BSP_SECURE_VECTOR_SET((uint32_t) & _Secure_Vectors
Project | Saved Templates
Console X Registers Problems Smart Browser Debugger Console Memory Executables =8
xBEREE 208~

freertos_w_awo_rzg3s_evk_example Debug_Flat [Renesas GDB Hardware Debugging] [pid: 14]
Kaw options i (1\Users\ad149usZ\.ec11pse \com. renesas. platiorm_1266 /26211 \Uebuglomp
Using J-Link version V8.6@ - C:\Users\a5149982\.eclipse\com.renesas.platform_1206726211\DebugComp\RZ\ARM\S

Connecting to R9AGSGE45S33_M33_8, ARM Target
GDBServer endian : little
Target power from emulator : OFf

Starting target connection

Finished target connection

GDB: 62588

Target connection status - OK

Target connection status - OK

Starting download

Finished download

Hardware breakpoint set at address @x26234

Figure 8.3 Run CM33 AWO Example Project (1)

4. Program should stop at the top of main function. Click Run > Run again to continue. Now, CM33 AWO
Example Program should be working.

5. Log in to Linux as root user.

8.2 Restrictions
This AWO Example environment has the following restrictions regarding the boot mode.

e CM33 coldboot is not supported. Use this environment with CA55 coldboot.
e eSD boot is not supported.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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